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Using SWO to print information 

from STM32



Using SWO 3

• On some stm32 is periphery called ITM, not mix with ETM(real trace)

• This periphery can be used to internal send data from MCU over SWO pin

• Is possible to redirect the printf into this periphery

• And also some IDEs can display this information during debug

• It is similar to USART but

we don’t need any additional

wires and PC terminal

• Video: Link

https://www.youtube.com/watch?v=lUPSqfO4ISk


Using SWO 4

• To make SWO working you musty connect the PA3 and Debugger SWO pin 

together

Connect SWO 

and PA3 

Connect SWO 

and PA3 



Using SWO for printf 5

• Create project in CubeMX

• Menu > File > New Project

• Select STM32F4 > STM32F429/439 > LQFP144 > STM32F439ZITx

• We need only blank project with clock initialization
• We set the RCC and configure the core to maximum speed and SWD with SWO



Using SWO for printf 6

• Now we set the project details for generation

• Menu > Project > Project Settings

• Set the project name

• Project location

• Type of toolchain

• Now we can Generate Code

• Menu > Project > Generate Code



Using SWO for printf in KEIL

• We need to include the stdio.h library to make printf working

• And define __FILE structure

• fputc function must be defined to send byte over ITM 
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/* USER CODE BEGIN Includes */
#include <stdio.h>
/* USER CODE END Includes */

/* USER CODE BEGIN PFP */
struct __FILE { int handle; /* Add whatever is needed */ };
/* USER CODE END PFP */

/* USER CODE BEGIN 4 */
/*send text over SWV*/
int fputc(int ch, FILE *f) {
ITM_SendChar(ch);//send method for SWV
return(ch);

}
/* USER CODE END 4 */



Using SWO for printf in KEIL

• If the MCU run on very high frequency and you not see print f output 

you may try put into ITM send delay loop
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/* USER CODE BEGIN 4 */
/*send text over SWV*/
int fputc(int ch, FILE *f) {
uint32_t i=0;
for(i=0;i<0xFFFF;i++);//waiting method, lower value will stop the SWV
ITM_SendChar(ch);//send method for SWV
return(ch);

}
/* USER CODE END 4 */



Using SWO for printf in KEIL

• In KEIL

• Open target options 

(ALT+F7)

• Set ST-Link debugger

• Button Settings

• Set SW(D)

in Debug TAB

• Got to Trace TAB
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1. Target 

options 2. Select 

DEBUG tab

3. Set ST-Link

4. Open Settings

5. Set SW(D)

6. Go to Trace tab



Using SWO for printf in KEIL

• Check Trace Enable

• Set core clock (168MHz must be same as in CubeMX clock tree)

• ITM Stimulus Port 0

must be checked

• Button OK
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4. Open Settings

1. Trace 

Enable

2. Set Core clock

3. Check ITM Port 0

4. Button OK



Using SWO for printf in KEIL

• Testing loop printf in main

• Compile and debug project

• Open Debug (printf) Viewer
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/* USER CODE BEGIN 3 */
/* Infinite loop */
while (1)
{
printf("test text\n");
HAL_Delay(1000);

}
/* USER CODE END 3 */



Using SWO for printf in IAR

• Here is configuration more easier

• Open project options

• General Options

• TAB library and configuration

• Select stdout/stderr via SWO

• Button OK
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2. Library configuration

1. General options

3. Set Via SWO



Using SWO for printf in IAR

• Add testing printf into loop

• Compile project and go to debug

• Open SWO
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/* USER CODE BEGIN 3 */
/* Infinite loop */
while (1)
{
printf("test text\n");
HAL_Delay(1000);

}
/* USER CODE END 3 */

Open SWO options



Using SWO for printf in IAR 14

• Override project default if clocks are different from core

(168MHz in out case)

• Check autodetect SWO clock if possible

• Enable 

ITM Port 0

to terminal

• Button OK
Override clock and set 

correct value (168MHz)

Check autodetect

Enable ITM Port 0

Button OK



Using SWO for printf in IAR 15

• Menu View -> Terminal I/O

• Run program



FreeRTOS



FreeRTOS

About FreeRTOS

• Market leading RTOS by Real Time Engineers Ltd.

• Professionally developed with strict quality management

• Commercial versions available: OpenRTOS and SafeRTOS

• Documentation available on www.freertos.org

• Free support through forum (moderated by RTOS original author 

Richard Barry)
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FreeRTOS

Main features
• Preemptive or cooperative real-time kernel

• Scalable RTOS with tiny footprint (less than 10KB  ROM)

• Includes a tickless mode for low power applications

• Synchronization and inter-task communications using 

• message queues

• binary and counting semaphores 

• mutexes 

• group events (flags)

• Software timers for tasks scheduling

• Execution trace functionality

• CMSIS-RTOS API port

18



FreeRTOS

APIs overview (1/2)
19

API category FreeRTOS API Description

Task creation xTaskCreate Creates a new task

vTaskDelete Deletes a task

Task control vTaskDelay Task delay

vTaskPrioritySet Sets task priority

vTaskSuspend Suspends a task

vTaskResume Resumes a task

Kernel control vTaskStartScheduler Starts kernel scheduler

vTaskSuspendAll Suspends all tasks

xTaskResumeAll Resumes all tasks

taskYIELD Forces a context switch

taskENTER_CRITICAL Enter a critical section (stops 

context switching)

taskEXIT_CRITICAL Exits from a critical section



FreeRTOS

APIs overview (2/2)
20

API 

category

FreeRTOS API Description

Message 

queues

xQueueCreate Creates a queue

xQueueSend Sends data to queue

xQueueReceive Receive data from the queue

Semaphores xSemaphoreCreateBinary Creates a binary semaphore

xSemaphoreCreateCounting Creates a counting semaphore

xSemaphoreCreateMutex Creates a mutex semaphore

xSemaphoreTake Semaphore take

xSemaphoreGive Semaphore give

Timers xTimerCreate Creates a timer

xTimerStart Starts a timer

xTimerStop Stops a timer



FreeRTOS

CMSIS-RTOS FreeRTOS implementation
• Implementation in file cmsis-os.c (found in folder: 

“\Middlewares\Third_Party\FreeRTOS\Source\CMSIS_RTOS”)

• The following table lists examples of the CMSIS-RTOS APIs and the FreeRTOS APIs 

used to implement them
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API category CMSIS_RTOS API FreeRTOS API

Kernel control osKernelStart vTaskStartScheduler

Thread management osThreadCreate xTaskCreate

Semaphore osSemaphoreCreate vSemaphoreCreateBinary

xSemaphoreCreateCounting

Mutex osMutexWait xSemaphoreTake

Message queue osMessagePut xQueueSend

xQueueSendFromISR

Timer osTimerCreate xTimerCreate

• Note: CMSIS-RTOS implements same model as FreeRTOS for task states



FreeRTOS

CMSIS-RTOS API
• CMSIS-RTOS API is a generic RTOS interface for Cortex-M processor based 

devices

• Middleware components using the CMSIS-RTOS API are RTOS agnostic, this 

allows an easy linking to any third-party RTOS

• The CMSIS-RTOS API defines a minimum feature set including

• Thread Management

• Kernel control

• Semaphore management

• Message queue and mail queue

• Memory management

• …

• For detailed documentation regarding CMSIS-RTOS refer to: 

http://www.keil.com/pack/doc/CMSIS/RTOS/html/index.html
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http://www.keil.com/pack/doc/CMSIS/RTOS/html/index.html


FreeRTOS

Configuration options
• Configuration options are declared in file FreeRTOSConfig.h

• Important configuration options are:
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Config option Description

configUSE_PREEMPTION Enables Preemption

configCPU_CLOCK_HZ CPU clock frequency in hertz

configTICK_RATE_HZ Tick rate in hertz

configMAX_PRIORITIES Maximum task priority

configTOTAL_HEAP_SIZE Total heap size for dynamic allocation

configLIBRARY_LOWEST_INTERRUPT_PRIORITY Lowest interrupt priority (0xF when 

using 4 cortex preemption bits)

configLIBRARY_MAX_SYSCALL_INTERRUPT_PRIORITY Highest thread safe interrupt priority 

(higher priorities are lower numeric 

value)



FreeRTOS

Tickless idle mode operation

• Kernel can stop system tick interrupt and place MCU in low power 

mode, on exit from this mode systick counter is updated

• Enabled when setting configUSE_TICKLESS_IDLE as 1 

• The kernel will call a macro portSUPPRESS_TICKS_AND_SLEEP() 

when the Idle task is the only task able to run (and no other task is 

scheduled to exit from blocked state after n ticks)

• n value is defined in FreeRTOSconf.h file

• FreeRTOS implementation of portSUPRESS_TICKS_AND_SLEEP

for cortexM3/M4 enters MCU in sleep low power mode

• Wakeup from sleep mode can be from a system interrupt/event

24



FreeRTOS in CubeMX 25

• Use CubeMX project from printf example

• In Pinout TAB select in MiddleWares FreeRTOS

• In Configuration TAB

is now possible to

configure FreeRTOS

Parameters



CubeMX FreeRTOS Configuration 26

• FreeRTOS configuration supported by

CubeMX

• Config parameters

• Set kernel 

• Mem setup

• Include parameters

• Include some additional functions,

not necessary for FreeRTOS run

• Tasks and Queues

• We can easily create task or queue by CubeMX

• Timers and semaphores

• CubeMX create semaphore and timer for us



Kernel settings 27

• Use preemption

• If enabled use pre-emptive scheduling

• If disabled use co-operative scheduling

Task1

Priority level

High priority

Low priority

time

Create Task2 Task1 suspend

Task2

Task1

Priority level

High priority

Low priority

time

Create Task2 Task2 suspend

Task1

Task2



FreeRTOS

Memory allocations types



FreeRTOS

Dynamic memory management
29

• FreeRTOS have own heap which is use for components

• Tasks

• Queues

• Semaphores

• Mutexes

• Dynamic memory allocation

• Is possible to select type of 

memory allocation
Total heap size for 

FreeRTOS

How is memory allocated 

and dealocated



Heap

FreeRTOS

Dynamic memory management
• Heap_1.c

• Simplest allocation method (deterministic), but does not allow freeing of allocated 

memory => could be interesting when no memory freeing is necessary
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Heap

Allocated 

block 2

Allocated 

block 1

Allocated 

block 2

pvPortMalloc

pvPortMalloc

pvPortMalloc

vPortFree

vPortFree

vPortFree

Is not possible to return 

memory to heap



Heap

FreeRTOS

Dynamic memory management
• Heap_2.c

• Implements a best fit algorithm for allocation

• Allows memory free operation but does not combine adjacent free blocks => risk of 

fragmentation
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Heap

Allocated 

block 2

Allocated 

block 1

Allocated 

block 2

pvPortMalloc

pvPortMalloc

pvPortMalloc

vPortFree

vPortFree

Heap 1

Heap 2

Allocated 

block 1

Heap 3

vPortFree

Heap 1

Heap 2

Heap 4

Heap 3

Free blocks are not 

combined together



Heap

FreeRTOS

Dynamic memory management
• Heap_3.c

• Implements a simple wrapper for the standard C library malloc() and free(), the 

wrapper makes these functions thread safe, but makes code increase and not 

deterministic
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Heap

Allocated 

block 2

Allocated 

block 1

Allocated 

block 2

malloc

malloc

malloc

free

free

Heap 1

Heap 2

Allocated 

block 1

Heap 3

free

Heap 1

Heap 2

Heap 4

Heap 3

Use C functions for allocation 

(linker must be modified)



Heap

FreeRTOS

Dynamic memory management
• Heap_4.c

• First fit algorithm and able to combine adjacent free memory blocks into a single 

block => this model is used in STM32Cube examples
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Heap

Allocated 

block 2

Allocated 

block 1

Allocated 

block 2

pvPortMalloc

pvPortMalloc

pvPortMalloc

vPortFree

vPortFree

vPortFree

Heap 1

Heap 2

Allocated 

block 1
vPortFree

Heap

combine together free 

memory



Memory allocation 34

• Use heap_4.c

• Memory Handler definition

• Memory allocation

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
osPoolDef(Memory,0x100,uint8_t);
PoolHandle = osPoolCreate(osPool(Memory));
uint8_t* buffer=osPoolAlloc(PoolHandle);
/* Infinite loop */
for(;;)
{

osDelay(5000);
}
/* USER CODE END 5 */

}

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;
osPoolId PoolHandle;

Allocate memory from pool

Create memory pool



FreeRTOS

Tasks



FreeRTOS

Task states
• Ready

• Tasks are ready to execute but are 

not currently executing because a 

different task with equal or higher 

priority is running

• Running

• when task is actually running 

• Blocked

• Task is waiting for a either a 

temporal or external event

• Suspended

• Task not available for scheduling

36

Suspend

Ready

Blocked

Runing
osThreadCreate

osThreadSuspend

osThreadSuspendosThreadSuspend

osThreadResume

Blocked API function

Event

Scheduler



FreeRTOS

Task switch
• Task switching on STM32?

• Cortex cores have implemented few 

features which directly support os

systems

• Two interrupts dedicated for os

• PendSV interrupt

• SVC interrupt

• Two stack pointers

• Process stack pointer

• Main stack pointer

• SysTick timer

• Used to periodically trigger 

scheduling

37



• PendSV interrupt

• In this interrupt is the scheduler

• Lowest NVIC interrupt priority

• Not triggered by any periphery

• Pending state set from other interrupts

• Or from task which want end earlier 

(non MPU version)

• SVC interrupt

• Interrupt risen by SVC instruction

• Called if task want end earlier (MPU 

version)

• In this interrupt set pending state 

PendSV (MPU version)

• SysTick timer

• Set PendSV is context switch is 

necessary

Task1

Priority level

High priority

Low priority

time

Task2

PendSV

SysTick

SVC

Other IRQs

Task1

osDelay

Task2

FreeRTOS OS interrupts 38



PendSV interrupt

FreeRTOS

Stack pointer
• Main stack pointer

• Used in interrupts

• Allocated by linker during compiling

• Process stack pointer

• Each task have own stack pointer

• During context switch the stack pointer is initialized 

for correct task

39

Task 1 Task 2

Stack – Task 1

Data

Stack – Task 1

Data

Non scratch 

registers

Stack – Task 2

Data

Non scratch 

registers

Stack – Task 2

Data

PSP stack pointer MSP stack pointer PSP stack pointer



Tasks API

• Create task

• Delete task

• Get task ID

• Task handle definition:

• Create Task

40

osThreadId osThreadCreate (const osThreadDef_t *thread_def, void *argument)

osStatus osThreadTerminate (osThreadId thread_id)

osThreadId osThreadGetId (void)

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;

/* Create the thread(s) */
/* definition and creation of Task1 */
osThreadDef(Task1, StartTask1, osPriorityNormal, 0, 128);
Task1Handle = osThreadCreate(osThread(Task1), NULL);



Tasks API

• Check if task is suspended

• Resume task

• Check state of task

• Suspend task

• Resume all tasks

• Suspend all tasks 

41

osThreadState osThreadGetState(osThreadId thread_id)

osStatus osThreadIsSuspended(osThreadId thread_id)

osStatus osThreadSuspend (osThreadId thread_id)

osStatus osThreadResume (osThreadId thread_id)

osStatus osThreadSuspendAll (void)

osStatus osThreadResumeAll (void)



Tasks lab

• By default defined one defaultTask

• Task is defined by 

• Name

• Priority

• Stack size

• Name of entry function

• Define two tasks

• Task1 

• Task2

• With same priority

42



Tasks lab

• Now we set the project details for generation

• Menu > Project > Project Settings

• Set the project name

• Project location

• Type of toolchain

• Now we can Generate Code

• Menu > Project > Generate Code

43



Tasks lab

• Any component in FreeRTOS need to have handle, very similar to CubeMX

• Task function prototypes, names was taken from CubeMX

• Before the scheduler is start we must create tasks

44

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;
osThreadId Task2Handle;

/* Private function prototypes -----------------------------------------------*/
void SystemClock_Config(void);
static void MX_GPIO_Init(void);
void StartTask1(void const * argument);
void StartTask2(void const * argument);

/* Create the thread(s) */
/* definition and creation of Task1 */
osThreadDef(Task1, StartTask1, osPriorityNormal, 0, 128);
Task1Handle = osThreadCreate(osThread(Task1), NULL);

/* definition and creation of Task2 */
osThreadDef(Task2, StartTask2, osPriorityNormal, 0, 128);
Task2Handle = osThreadCreate(osThread(Task2), NULL);

Define task parameters

Create task, allocate 

memory



Tasks lab

• Start the scheduler, the scheduler function newer ends

• On first task run StartTask1 is called

• Task must have inside infinity loop in case we don’t want to end the task

45

/* Start scheduler */
osKernelStart();
/* We should never get here as control is now taken by the scheduler */

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

printf("Task 1\n");
osDelay(1000);

}
/* USER CODE END 5 */

}

Endless loop

osDealy will start 

context switch



Tasks lab

• Second loop is same as previous

• Compile and run project in debug and watch terminal window

46

/* StartTask2 function */
void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

printf("Task 2\n");
osDelay(1000);

}
/* USER CODE END StartTask2 */

}



Tasks lab

• If both Dealys are processed the FreeRTOS is in idle state
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Task1

Priority level

High priority

Low priority

time

osDelay osDelay

Task2 Task1Task1

osDelay osDelay

Task2

Delay ends

Idle

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2



Tasks lab

• Without Delays the threads will be in running state or in Ready state

• Use HAL_Delay
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Task1

Priority level

High priority

Low priority

time

SysTick SysTick

Task2 Task1Task1

SysTick SysTick

Task2

SysTick

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing
Task1

Task2



Tasks lab

• Set one task Higher priority

• Double click on task for change

• Button OK

49



Tasks lab

• After we 5x times send text put task to block state

• Because task have high priority it allow to run lower priority task

50

/* USER CODE END 4 */
void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
uint32_t i = 0;
/* Infinite loop */
for(;;)
{

for (i = 0; i < 5; i++){
printf("Task 1\n");
HAL_Delay(50);

}
osDelay(1000);

}
/* USER CODE END 5 */

}

Helps not spam terminal

Block task



Tasks lab

• If higher priority task is not running we can print text from this task
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/* StartTask2 function */
void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

printf("Task 2\n");
HAL_Delay(50);

}
/* USER CODE END StartTask2 */

}

Helps not spam terminal



Tasks lab

• What happen if Task1 not call osDelay?
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Task1

Priority level

High priority

Low priority

time

osDelay Delay end

Task2

Task1Task1

Delay end osDelay

Task2

osDelay

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing
Task1

Task2

Suspend

Ready

Blocked

Runing

Task1

Task2

Suspend

Ready

Blocked

Runing
Task1

Task2



osDelay API

• Delay function

• Delay function which measure time from which is delay measured

osStatus osDelay (uint32_t millisec)

53

osStatus osDelayUntil (uint32_t PreviousWakeTime, uint32_t millisec)



osDelay function

Task 2

Pri 2

PendS

V

Task 2

Pri 2

Task 1 - Pri 1

Task 2 - Pri 2

vTaskDela

y
PendSV(idle)

vTaskDela

y

Task 2

Delay end

Task 1

Pri 1

Delay time

• osDelay start measure time from osDelay call

54



osDelayUntil

Task 2

Pri 2

PendSV

Task 2

Pri 2

Task 1 - Pri 1

Task 2 - Pri 2

vTaskDelay

Until
PendSV(idle)vTaskDelay

Task 2

Delay end

Task 1

Pri 1

DelayUntil time

• osDelayUntil measure time from point which we selected

• This allow us to call task in regular intervals

55



osDelay and osDelayUntil

• Enable vTaskDelayUntil in Include parameters

• Regenerate project, modify tasks to:

56

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
uint32_t i = 0;
/* Infinite loop */
for(;;)
{
printf("Task 1\n");
HAL_Delay(1000);
osDelay(2000);

}
/* USER CODE END 5 */

}

/* StartTask2 function */
void StartTask2(void const * argument)
{
/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{
printf("Task 2\n");
HAL_Delay(200);

}
/* USER CODE END StartTask2 */

}

Delay between two 

run is 2s



osDelay and osDelayUntil

• Enable vTaskDelayUntil in Include parameters

• Regenerate project, modify tasks to:

57

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
uint32_t wakeuptime;
/* Infinite loop */
for(;;)
{

wakeuptime=osKernelSysTick();
printf("Task 1\n");
HAL_Delay(1000);
osDelayUntil(wakeuptime,2000);

}
/* USER CODE END 5 */

}

Function will be 

executed every 2s

Real delay timeTime from 

which is delay 

measured

For osDelayUntil function 

we need mark wakeup 

time



Priority change lab

• Task1 have higher priority 

than Task2

• If not enable vTaskPriorityGet

and uxTaskPrioritySet

in IncludeParameters

58



Priority change lab

• Modify Task1 to:

59

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
osPriority priority;
/* Infinite loop */
for(;;)
{

priority=osThreadGetPriority(Task2Handle);
printf("Task 1\n");
osThreadSetPriority(Task2Handle,priority+1);
HAL_Delay(1000);

}
/* USER CODE END 5 */

}

Increase Task2 priority

Reads Task2 priority



Priority change lab

• Modify Task2 to:

60

/* StartTask2 function */
void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
osPriority priority;
/* Infinite loop */
for(;;)
{

priority=osThreadGetPriority(NULL);
printf("Task 2\n");
osThreadSetPriority(NULL,priority-2);

}
/* USER CODE END StartTask2 */

}

Decrease task priority

Read priority of current task



Priority change lab

• How priorities are changed?

61

Task 1

Pri 6
PendSV

Task 1

Pri 6

Task 1 - Pri 6

Task 2 - Pri 4

vTaskPrioritySet

Task 2 Pri +1

Task 2

Pri 6

PendSV
vTaskPrioritySet

Task 2 Pri -2

vTaskPrioritySet

Task 2 Pri +1
PendSV

Task 1

Pri 6

Task 2 - Pri 5 Task 2 - Pri 6 Task 2 - Pri 4



Creating and deleting tasks lab

• Example how to create and delete tasks

62

Task 1

Pri 1

Task 1

Pri 1

Task 1 - Pri 1

vTaskDelay PendSV(idle)

Task 1

Delay end

Task 2

Pri 2

vTaskDelete

xTaskCreate

Task 1

Pri 1

PendSV

PendSV



Creating and deleting tasks lab

• Example how to create and delete tasks

• Comment Task2 creation part in main.c

• Modify Task1 to create task2

63

/* definition and creation of Task2 */
//  osThreadDef(Task2, StartTask2, osPriorityNormal, 0, 128);
//  Task2Handle = osThreadCreate(osThread(Task2), NULL);

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

printf("Create task2");
osThreadDef(Task2, StartTask2, osPriorityNormal, 0, 128);
Task2Handle = osThreadCreate(osThread(Task2), NULL);
osDelay(1000);

}
/* USER CODE END 5 */

}

Task 2 creation



Creating and deleting tasks lab

• Example how to create and delete tasks

• Modift Task2 to delete him-self:

64

/* StartTask2 function */
void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

printf("Delete Task2\n");
osThreadTerminate(Task2Handle);

}
/* USER CODE END StartTask2 */

}

Delete Task



FreeRTOS

Queues



Receiver Task

osMessageGet

Receiver Task

Receiver Task

Receiver Task

osMessageGet

Receiver Task

Message 2

Message 2

Message 1

Message 1

Queue 66

Sender Task

osMessagePut

Message 1

Sender Task

osMessagePut

Sender Task

Sender Task

Sender Task

Message 2



Queue

• Create Queue:

• Put data into Queue

• Receive data from Queue

67

osMessageQId osMessageCreate (const osMessageQDef_t *queue_def, osThreadId thread_id)

osStatus osMessagePut (osMessageQId queue_id, uint32_t info, uint32_t millisec)

osEvent osMessageGet (osMessageQId queue_id, uint32_t millisec)

Create QueueQueue Handle

Item to sendQueue Handle Send timeout

Queue handleStructure with status 

and with received 

item

Receiving timeout



Queue

• osEvent structure

• If we want to get data from osEvent we must use:

• osEventName.v if the value is 32bit message(or 8/16bit)

• osEventName.p and retype on selected datatype

68

typedef struct {
osStatus status;     ///< status code: event or error information
union {

uint32_t                    v;     ///< message as 32-bit value
void *p;     ///< message or mail as void pointer
int32_t               signals;     ///< signal flags

} value;                             ///< event value
union {

osMailQId mail_id;     ///< mail id obtained by \ref osMailCreate
osMessageQId message_id;     ///< message id obtained by \ref osMessageCreate

} def;                               ///< event definition
} osEvent;



Queue lab

• Set both tasks to normal priority

• Queue part

• Button Add

• Set queue size to 256

• Queue type to uint8_t

• Button OK
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Queue lab

• Queue handler is now defined

• Queue item type initialization, length definition and create of queue and 

memory allocation
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/* Private variables ---------------------------------------------------------*/
osThreadId Sender1Handle;
osThreadId ReceiverHandle;
osMessageQId Queue1Handle;

/* Create the queue(s) */
/* definition and creation of Queue1 */
osMessageQDef(Queue1, 256, uint8_t);
Queue1Handle = osMessageCreate(osMessageQ(Queue1), NULL);

Queue item definition

Queue size



Queue lab

• Sender1 task

71

void StartSender1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

printf("Task1\n");
osMessagePut(Queue1Handle,0x1,200);
printf("Task1 delay\n");
osDelay(1000);

}
/* USER CODE END 5 */

}

Put value ‘1’ into queue

Queue handle

Item to send

Timeout for send
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• Teceiver task
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/* StartReceiver function */
void StartReceiver(void const * argument)
{

/* USER CODE BEGIN StartReceiver */
osEvent retvalue;
/* Infinite loop */
for(;;)
{

printf("Task2\n");
retvalue=osMessageGet(Queue1Handle,4000);
printf(“%d \n",retvalue.value.p);

}
/* USER CODE END StartReceiver */

}

Get item from queue

Queue handle

How long we wait on data in 

queue

It will Block task



Receiver Task

Blocked

Receiver TaskReceiver Task

Blocked

Receiver Task

Blocked

Sender Task

Receiver Task

osMessageGet

Receiver Task

Message 1

Queue Blocking 73

Sender Task

Message 1

osMessagePut

Sender Task

Sender Task

osMessageGet

osMessageGet
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Receiver 

Pri 1

PendSV

Sender1 

Pri 1

Sender1- Pri 1

xQueueReceive

Sender1 

Pri 1

Receiver- Pri 1

PendSVxQueueSend

Receiver 

Pri 1

PendSVxQueueReceive

• After calling osMessageGet

• If any data are not in queue the task I blocked for settable time

• If the data are in queue the task will continue
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• Two sending tasks

• One receivers tasks

• Same priorities
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• Two sending tasks

• They are same no change necessary

void StartSender1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

printf("Task1\n");
osMessagePut(Queue1Handle,0x1,200);
printf("Task1 delay\n");
osDelay(2000);

}
/* USER CODE END 5 */

}

void StartSender2(void const * argument)
{

/* USER CODE BEGIN StartSender2 */
/* Infinite loop */
for(;;)
{

printf("Task2\n");
osMessagePut(Queue1Handle,0x2,200);
printf("Task2 delay\n");
osDelay(2000);

}
/* USER CODE END StartSender2 */

}
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• Simple receiver

/* StartReceiver function */
void StartReceiver(void const * argument)
{

/* USER CODE BEGIN StartReceiver */
osEvent retvalue;
/* Infinite loop */
for(;;)
{   

retvalue=osMessageGet(Queue1Handle,4000);
printf("Receiver\n");
printf("%d \n",retvalue.value.p);

}
/* USER CODE END StartReceiver */

}
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• What we can see in debug now?

• Because tasks have same priority, receiver will get data from queue after both 

task put data into queue

• What happened if will be more tesks?

Receiver 

Pri 1

PendSV

Sender1- Pri 1

xQueueReceive

Sender1 

Pri 1
Receiver- Pri 1

xQueueSend

Sender2- Pri 1

Sender1 

Pri 1

PendSV

Receiver 

Pri 1

PendSVxQueueReceive

PendSV

Sender2 

Pri 1

xQueueSend
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• Senders have same priority

• Receiver have higher priority than 

senders
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• Receiver is now unblocked every time when sender tasks put data into queue

Receiver 

Pri 2

PendSV

Sender2 

Pri 1

Sender1- Pri 1

Sender2- Pri 1

xQueueReceive

Sender1 

Pri 1

Receiver- Pri 2

PendSVxQueueSend

Receiver 

Pri 2

PendSVxQueueReceive

Sender1 

Pri 1

PendSVxQueueSend

Receiver 

Pri 2

xQueueReceive
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• Queues allow to define type

(different variables or structures) 

which the queue use. 

• Regenerate project
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• Item size will be structure called

Data
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• Create new structure type for data

• Define Structures which will be sent from sender task

/* Define the structure type that will be passed on the queue. */
typedef struct
{

uint8_t Value;
uint8_t Source;

} Data;

/* Declare two variables of type Data that will be passed on the queue. */
Data DataToSend1={10,1};
Data DataToSend2={20,2};
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• Sent data from Sender task

void StartSender1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

printf("Task1\n");
osMessagePut(Queue1Handle,(uint32_t)&DataToSend1,200);
printf("Task1 delay\n");
osDelay(2000);

}
/* USER CODE END 5 */

}

Put data into queue



/* StartReceiver function */
void StartReceiver(void const * argument)
{

/* USER CODE BEGIN StartReceiver */
osEvent retvalue;
/* Infinite loop */
for(;;)
{   

retvalue=osMessageGet(Queue1Handle,4000);
if(((Data*)retvalue.value.p)->Source==1){

printf("Receiver Receive message from Sender 1\n");
}else{

printf("Receiver Receive message from Sender 2\n");
}
printf("Data: %d \n",((Data*)retvalue.value.p)->Value);

}
/* USER CODE END StartReceiver */

}

Queue items lab 85

• Receiver data from sender task

Get data from queue

Decode data from osEvent structure



FreeRTOS

Semaphores
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• Used for synchronization between

• Tasks

• Interrupt and task

• Two types

• Binary semaphores

• Counting semaphores

• Binary semaphore

• Have only one ‘token’

• Using to synchronize one action

• Counting semaphore

• Have multiple ‘tokens’ 

• Synchronize multiple actions



Task2

Blocked

Task2

Task2Task2

Blocked

Binary Semaphore 88

Task1

osSemaphoreWait

Task2

Blocked

Task1

osSemaphoreRelease osSemaphoreWait

Task1

osSemaphoreWait

Task2Task1

osSemaphoreRelease

Task2Task1

osSemaphoreWait
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• Semaphore creation

• Wait for Semaphore release

• Semaphore release

osSemaphoreId osSemaphoreCreate (const osSemaphoreDef_t *semaphore_def, int32_t count)

int32_t osSemaphoreWait (osSemaphoreId semaphore_id, uint32_t millisec)

osStatus osSemaphoreRelease (osSemaphoreId semaphore_id)

Semaphore 

handle

Semaphore 

definition
Semaphore ‘tokens’

For binary semaphore 

is 1

Semaphore 

handle
How long wait for 

semaphore release

Semaphore 

handle

Return 

status

Number of ‘tokens 

in semaphore’
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• Create two tasks

• With same priority

• Button Add

• Set parameters

• Button OK
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• Create binary binary semaphore

• Button Add

• Set name

• Button OK
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• Task1 is synchronized with Task2

Task1 - Pri 1

Task2 - Pri 1

Task1

Pri 1

PendSV
osSemaphore

Wait

Task2

Pri 1

PendSV
osSemaphore

Release

Task1 

Pri 1

PendSV
osSemaphore

Wait

Task2

Pri 1
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• Semaphore handle definition

• Semaphore creation

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;
osThreadId Task2Handle;
osSemaphoreId myBinarySem01Handle;

/* Create the semaphores(s) */
/* definition and creation of myBinarySem01 */
osSemaphoreDef(myBinarySem01);
myBinarySem01Handle = osSemaphoreCreate(osSemaphore(myBinarySem01), 1);
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• Semaphore use

• If tasks/interrupt is done the semaphore is released

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
printf("Task1 Release semaphore\n");
osSemaphoreRelease(myBinarySem01Handle);  

}
/* USER CODE END 5 */

}
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• Semaphore Wait

• Second task waits on semaphore release

After releasetask is unbocked and continue in work

void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

osSemaphoreWait(myBinarySem01Handle,4000);
printf("Task2 synchronized\n");

}
/* USER CODE END StartTask2 */

}
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• Os API same as Binary semaphore

• Semaphore creation

• Wait for Semaphore release

• Semaphore release

osSemaphoreId osSemaphoreCreate (const osSemaphoreDef_t *semaphore_def, int32_t count)

int32_t osSemaphoreWait (osSemaphoreId semaphore_id, uint32_t millisec)

osStatus osSemaphoreRelease (osSemaphoreId semaphore_id)



Task3

Blocked

Task3

Task3

Task3Task3
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Task2

Task2

Task1

osSemaphoreRelease

Task1

osSemaphoreRelease

Task2

Blocked

Task3Task2

osSemaphoreWait

Task1

Task2

Blocked

Task3Task2

osSemaphoreWait

Task1

Task2

osSemaphoreWait

Task1
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• Create three tasks

• With same priority

• Button Add

• Set parameters

• Button OK
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• Create Counting semaphore

• Set count of tokens

• Button Add

• Set name

• Button OK
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• Task1 and Task2 release semaphore

• Task 3 wait for two tokens

Task1- Pri 1

Task2- Pri 1

Task3 

Pri 1

PendSV
osSemaphore

Wait

Task1

Pri 1

PendSV
osSemaphore

Release

Task2

Pri 1

PendSV
osSemaphore

Release

Task3

Pri 1

Task3- Pri 1

Task3 

Pri 1

PendSV
osSemaphore

Wait

Task1

Pri 1

osSemaphore

Release
osSemaphore

Wait
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• Create Counting semaphore

• Task1 and Task2 will be same

/* Create the semaphores(s) */
/* definition and creation of myCountingSem01 */
osSemaphoreDef(myCountingSem01);
myCountingSem01Handle = osSemaphoreCreate(osSemaphore(myCountingSem01), 2);

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
printf("Task1 Release counting semaphore\n");
osSemaphoreRelease(myCountingSem01Handle);  

}
/* USER CODE END 5 */

}

void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
printf("Task2 Release counting semaphore\n"
osSemaphoreRelease(myCountingSem01Handle);

}
/* USER CODE END StartTask2 */

}
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• Task3 will wait until semaphore will be 2 times released

void StartTask3(void const * argument)
{

/* USER CODE BEGIN StartTask3 */
/* Infinite loop */
for(;;)
{
osSemaphoreWait(myCountingSem01Handle, 4000);
osSemaphoreWait(myCountingSem01Handle, 4000);
printf("Task3 synchronized\n");
}
/* USER CODE END StartTask3 */

}



FreeRTOS

Mutex



Task2

Blocked

Task2Task2

Blocked

ResourseResource
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Task1

osMutexWait

Task2

Blocked

Resourse

Task1

osMutexRelease Resource

Resourse

Task2

Resource

Task1

osMutexWait

Task2

Resourse

Task1

osMutexRelease

Resource

osMutexWait

osMutexWait

• Used to guard access to limited recourse

• Work very similar as Semaphores
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• Mutex creation

• Wait for Mutex release

• Mutex release

osMutexId osMutexCreate (const osMutexDef_t *mutex_def)

osStatus osMutexWait (osMutexId mutex_id, uint32_t millisec)

osStatus osMutexRelease (osMutexId mutex_id)

Mutex

handle

Mutex

definition

Mutex

handle
How long wait for 

mutex release

Mutex

handle

Return 

status

Return status
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• Create two tasks

• With same priority

• Button Add

• Set parameters

• Button OK
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• Create Mutex

• Button Add

• Set name

• Button OK
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• Both tasks using printf function.

• Mutex is used to avoid collisions

Task1- Pri 1

Task1

Pri 1

Task2- Pri 1

PendSVosMutexWait

Task2

Pri 1

osMutexReleasePrint osDelay osMutexWait Print

Only one task can have semaphore
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• Mutex handle definition

• Mutex creation

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;
osThreadId Task2Handle;
osMutexId myMutex01Handle;

/* Create the mutex(es) */
/* definition and creation of myMutex01 */
osMutexDef(myMutex01);
myMutex01Handle = osMutexCreate(osMutex(myMutex01));
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• Semaphore use

• If tasks/interrupt is done the semaphore is released

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
printf("Task1 Release semaphore\n");
osSemaphoreRelease(myBinarySem01Handle);  

}
/* USER CODE END 5 */

}
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• Task1 and Task2 using of Mutex

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
osMutexWait(myMutex01Handle,1000);
printf("Task1 Print\n");
osMutexRelease(myMutex01Handle);

}
/* USER CODE END 5 */

}

void StartTask2(void const * argument)
{

/* USER CODE BEGIN StartTask2 */
/* Infinite loop */
for(;;)
{

osDelay(2000);
osMutexWait(myMutex01Handle,1000);
printf("Task2 Print\n");
osMutexRelease(myMutex01Handle);

}
/* USER CODE END StartTask2 */

}



FreeRTOS

Software Timers



Software Timers 113

• Software timer is one of component in RTOS

• Can extend number of Timers in STM32

• Are not precise but can handle periodic actions or delay actions

• Two modes

• Periodic

• One Pulse

Task1

osTimerStart

Software timer counting

Software 

Timer Callback

Software timer counting

Software 

Timer Callback

Software timer counting

Task1

osTimerStart

Software timer counting

Software 

Timer Callback
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• Software timer creation

• Software timer start

• Software timer stop

osTimerId osTimerCreate (const osTimerDef_t *timer_def, os_timer_type type, void *argument)

osStatus osTimerStart (osTimerId timer_id, uint32_t millisec)

osStatus osTimerStop (osTimerId timer_id)

Timer

handle
Timer definition

Timer

handle
Timer period

Timer handle
Return 

status

Return status

Repeat timing or 

onetime timing
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• Software timers are by 

default disabled in CubeMX

• FreeRTOS configuration

• Configuration TAB

• Enable Software timers
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• Create one task

• Button Add

• Set parameters

• Set name

• Button OK
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• Create Timer

• Button Add

• Set timer name

• Timer callback name

• Button OK
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• Software timer handle definition

• Software timer creation

•

• Software timer start

/* Private variables ---------------------------------------------------------*/
osThreadId Task1Handle;
osTimerId myTimer01Handle;

/* Create the timer(s) */
/* definition and creation of myTimer01 */
osTimerDef(myTimer01, Callback01);
myTimer01Handle = osTimerCreate(osTimer(myTimer01), osTimerPeriodic, NULL);

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
osTimerStart(myTimer01Handle,1000);
/* Infinite loop */
for(;;)
{

osDelay(2000);
printf("Task1 Print\n");

}
/* USER CODE END 5 */

}
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• Software timer callback

/* Callback01 function */
void Callback01(void const * argument)
{

/* USER CODE BEGIN Callback01 */
printf("Timer Print\n");
/* USER CODE END Callback01 */

}



FreeRTOS advanced

Hooks
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• Callbacks supported by FreeRTOS core

• Can help with FreeRTOS fault handling

• Type of hooks:

• Idle Hool

• Tick Hook

• Malloc Failed Hook

• Stack Overflow Hook

• CubeMX will create hooks in freertos.c file
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• If the scheduler cannot run any task

it goes into idle mode

• Idle hook is callback from idle mode

• In to this task is possible to put 

power saving function
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• Idle hook callback in freertos.c created by CubeMX

• Do not use blocking functons(osDelay, …) in this function or while(1)

/* USER CODE END FunctionPrototypes */
/* Hook prototypes */
void vApplicationIdleHook(void);

/* USER CODE BEGIN 2 */
void vApplicationIdleHook( void )
{

/* vApplicationIdleHook() will only be called if configUSE_IDLE_HOOK is set
to 1 in FreeRTOSConfig.h. It will be called on each iteration of the idle
task. It is essential that code added to this hook function never attempts
to block in any way (for example, call xQueueReceive() with a block time
specified, or call vTaskDelay()). If the application makes use of the
vTaskDelete() API function (as this demo application does) then it is also
important that vApplicationIdleHook() is permitted to return to its calling
function, because it is the responsibility of the idle task to clean up
memory allocated by the kernel to any task that has since been deleted. */

}
/* USER CODE END 2 */
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• If the scheduler cannot run any task

it goes into idle mode

• Idle hook is callback from idle mode

• In to this task is possible to put 

power saving function
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• Idle hook callback in freertos.c created by CubeMX

• Do not use blocking functons(osDelay, …) in this function or while(1)

/* USER CODE END FunctionPrototypes */
/* Hook prototypes */
void vApplicationIdleHook(void);

/* USER CODE BEGIN 2 */
void vApplicationIdleHook( void )
{

/* vApplicationIdleHook() will only be called if configUSE_IDLE_HOOK is set
to 1 in FreeRTOSConfig.h. It will be called on each iteration of the idle
task. It is essential that code added to this hook function never attempts
to block in any way (for example, call xQueueReceive() with a block time
specified, or call vTaskDelay()). If the application makes use of the
vTaskDelete() API function (as this demo application does) then it is also
important that vApplicationIdleHook() is permitted to return to its calling
function, because it is the responsibility of the idle task to clean up
memory allocated by the kernel to any task that has since been deleted. */

}
/* USER CODE END 2 */
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• Every time the SysTick interrupt is 

trigger the TickHook is called

• Is possible use TickHook for periodic 

events like watchdog refresh
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• Tick hook callback in freertos.c created by CubeMX

• Do not use blocking functons(osDelay, …) in this function or while(1)

/* Hook prototypes */
void vApplicationTickHook(void);

/* USER CODE BEGIN 3 */
void vApplicationTickHook( void )
{

/* This function will be called by each tick interrupt if
configUSE_TICK_HOOK is set to 1 in FreeRTOSConfig.h. User code can be
added here, but the tick hook is called from an interrupt context, so
code must not attempt to block, and only the interrupt safe FreeRTOS API
functions can be used (those that end in FromISR()). */

}
/* USER CODE END 3 */
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• This callback is called if the memory 

allocation process fails

• Helps to react on malloc problems,

when function return is not handelt
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• Malloc Failed hook callback in freertos.c created by CubeMX

• Do not use blocking functons(osDelay, …) in this function or while(1)

/* Hook prototypes */
void vApplicationMallocFailedHook(void);

/* USER CODE BEGIN 5 */
void vApplicationMallocFailedHook(void)
{

/* vApplicationMallocFailedHook() will only be called if
configUSE_MALLOC_FAILED_HOOK is set to 1 in FreeRTOSConfig.h. It is a hook
function that will get called if a call to pvPortMalloc() fails.
pvPortMalloc() is called internally by the kernel whenever a task, queue,
timer or semaphore is created. It is also called by various parts of the
demo application. If heap_1.c or heap_2.c are used, then the size of the
heap available to pvPortMalloc() is defined by configTOTAL_HEAP_SIZE in
FreeRTOSConfig.h, and the xPortGetFreeHeapSize() API function can be used
to query the size of free heap space that remains (although it does not
provide information on how the remaining heap might be fragmented). */

}
/* USER CODE END 5 */
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• Malloc fail test

• Malloc fail hook:

• Do impossible memory allocation

/* USER CODE BEGIN 5 */
void vApplicationMallocFailedHook(void)
{

printf("malloc fails\n");
}
/* USER CODE END 5 */

void StartTask1(void const * argument)
{

/* USER CODE BEGIN 5 */
osPoolDef(Memory,0x10000000,uint8_t);
/* Infinite loop */
for(;;)
{

PoolHandle = osPoolCreate(osPool(Memory));
osDelay(5000);

}
/* USER CODE END 5 */

}

/* Private variables ---------------------------------------------------------
osThreadId Task1Handle;
osPoolId PoolHandle;

Impossible memory allocation
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• FreeRTOS is able to check stack

against overflow

• Two options

• Option 1

• FreeRTOS check if the stack is in range 

which was defined on task creation

• Option 2

• FreeRTOS use Option 1

• Secondary on the bottom of the stack is 

known pattern

• If pattern is overwritten the stack is corrupted
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• Stack overflow hook callback in freertos.c created by CubeMX

• Do not use blocking functons(osDelay, …) in this function or while(1)

/* Hook prototypes */
void vApplicationStackOverflowHook(xTaskHandle xTask, signed char *pcTaskName);

/* USER CODE BEGIN 4 */
void vApplicationStackOverflowHook(xTaskHandle xTask, signed char *pcTaskName)
{

/* Run time stack overflow checking is performed if
configCHECK_FOR_STACK_OVERFLOW is defined to 1 or 2. This hook function is
called if a stack overflow is detected. */

}
/* USER CODE END 4 */



End

Thanks for your attention


